
 New Features Version 7.310 

 July 2024 2 

 

 

   

Contents 
Introduction ........................................................................................................................................................ 3 

Main Features .................................................................................................................................................... 4 

AI Fault Indicator Creation ............................................................................................................................. 4 
Automated Fault Surface Extraction ............................................................................................................. 7 

FUNCTIONAL ENHANCEMENTS .................................................................................................................... 9 

Volume Editor Viewer PNG Export................................................................................................................ 9 
Surveys & Grids Loaded-Section indicators ................................................................................................ 10 
Display Method Attribute Histogram ............................................................................................................ 11 
Data-Offset for Wells and Surveys .............................................................................................................. 12 
Convert Field-Lines to Shapes .................................................................................................................... 13 
Polygon Centre-Lines .................................................................................................................................. 14 
Colourmap Import/Export ............................................................................................................................ 17 

 

NEW FEATURES 

T7.310 UPDATE 



 New Features Version 7.310 

 July 2024 3 

INTRODUCTION 

This document describes the new features and enhancements that make up the 
T7.310 update release and differentiate it from the latest T7.300 releases. T7.310 is 
distributed as a patch release and must be installed onto an existing 7.30x installation as a 
patch.  For a full description of  the new features please refer to the relevant sections in 
the T7 user-manual. This document and the end-user manual uses the term "T7" and 
“TrapTester” when referring to the current release version of the software. 

Important Notes: 

1) T7 license feature versions are “7.3”. T7.3 will not function with a T7.2 (or ealier) 
license.  Please send T7.3 license requests to support@badleys.co.uk. 

2) Some new features may require specific license feature-lines to unlock their 
functionality. Please contact support@badleys.co.uk to check eligibility and obtain 
the required license. 

3) T7.3 uses FlexNet 11.18.2 for its licensing.  The installation will include the 11.18.2 
version of the FlexNet license manager daemon. 

4) Once installed, T7 may need to run a database upgrade on existing projects.  
Please backup you projects before using them with T7.310.  Once a project 
database has been upgraded it will not be accessible using older versions of the 
software. 

5) After a project has been upgraded, the Volume Editor default shortcut file (defining 
hotkeys) will be replaced with an updated set of hotkeys and shortcuts. The 
original shortcut definition file will be renamed to "default.7.3xx". 

  

mailto:support@badleys.co.uk
mailto:support@badleys.co.uk
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MAIN FEATURES 

AI Fault Indicator Creation 

Requires AIFaults license feature 

A new AI auto-fault identification tool has been added to T7. This employs deep learning 
technologies in order to perform semantic segmentation on seismic amplitude volumes 
(although other volume types can be used too) in order to create fault indicator volumes. 
The tool enables both model training and inference.  

The AI tool takes the form of a wizard with five main tabs (outline below) that take the user 
through the entire workflow from model creation right to volume output. The tool can be 
launched from the Interpret main ribbon or from the “Sections” dropdown menu: 

 

MODEL 

Here the user picks/edits a survey, seismic access definition (volume) and a T7 artificial 
intelligence learning model (AILM) – see manual for details.  

TRAINING THE AI MODEL 

Here the user can define what sections they wish to use and create the AI fault training set 
(akin to fault picking). Once a number of sections (typically two or three) have been 
interpreted the model can be trained. This data can either be used to refine an optional 
pretrained model or to create an entirely new model. Alternatively, the training step can be 
by-passed altogether by using a pre-trained model without any fine-tuning. 
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MODEL INFERENCE 

Once the model has been created/chosen/trained it can be used to “infer” fault locations 
on the input seismic volume. It should be noted that there are number of options (see T7 
manual for details) here that can affect the quality of the output. It is best to experiment 
with these before performing inference on an entire volume. Typically, one would wish to 
operate on a small number of sections first to see what the best settings are for inference. 
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PROCESSING 

After running the model you can view the output results in the processing tab. This 
provides a list of the sections upon which the AI model has been run. By selecting a 
section you can view the results in an accompanying viewer. The output is not a true 
indicator but instead a probability field that be can be modified using a number of different 
processing steps (see T7 manual for details). These help reduce noise, highlight areas of 
high fault probability and provide more continuous outputs. Again, these are presented as 
a series of options. It is typically worthwhile undergoing a small series of cycles of 
inference and processing before running the model on a significant portion of an amplitude 
volume. 

 

OUTPUT 

As the name suggests this tab is used to write the results from model inference to a BGL 
volume that can then be treated like any other data volume (loaded alongside seismic data 
in Volume Editor). The data can be integrated into other existing volumes or new volumes 
can be created depending on the output settings – see T7 manual for details. 

The output volumes can be used as input into the “Automated Fault Surface Extraction” 
tool – described below. 
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Automated Fault Surface Extraction 

Requires AIFaults license feature 

With the implementation of the AI Fault Indicator Volume Creation (described above), T7.3 
also provides a tool for extracting fault surfaces as tri-meshes from such a volume. This 
new tool will operate on any fault indicator volume – generated through T7 or by a third-
party system. The new tool is accessed from the Model & Map tab in the Volume Editor. 

 

 
The various controls are described below. 

3D FAULT INDICATOR VOLUME 

Specify the fault indicator volume to be processed. 

If the input volume has already been used for an extraction process, it is possible to use 
the “Restart” option to re-run the later phases of the extraction with different options. 
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FAULT INDICATOR VALUES 

Define the input volume(s) sample value range that represents the fault data and 
differentiates it from non-fault data. 

Set the “Extraction direction” to define how the extraction procedure will analyze the input 
indicator volume: row by row or column by column. 

EXTRACTION EXTENTS 

Define the input volume row, column and Z-range to use for fault surface extraction. 

NEW (EXTRACTED) FAULT OPTIONS 

• Set a prefix to be used to name the faults created during the extraction process. 

• Define the colour of the faults created – or whether to use a colour sequence. 

• Define a surface grid cell dimension as a multiple of the input volume sample size.  

• Choose whether or not to group the smaller faults into a single “fragments” object. 

• Choose whether or not to load the extracted faults upon completion. 

• Choose whether or not to add all the extracted faults to a new list upon completion. 

 

Example AI Indicator Volume and Fault Surface Extraction 

The Fault Surface Extraction process can create large numbers of faults which can be 
unwieldy to manage. The Fault Surface Selection Tool (introduced in T7.3 and described 
in detail in the T7 Reference Manual) can be used to manage the selection and display of 
fault surfaces based on their geometric properties (dip, strike, size). 

ADVANCED CONTROLS 

The Advanced Controls can be used to fine tune the extraction process. Refer to the T7 
Reference Manual for full details. 
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FUNCTIONAL ENHANCEMENTS 

Volume Editor Viewer PNG Export 

In addition to the existing Hardcopy feature, Volume Editor now has the ability to save the 
current viewer contents to a PNG file. 

The option can be located in the Home tab toolbar and menu bar: 

 

Clicking the icon or menu item displays a dialog that allows the output PNG and image 
size to be specified: 

 

The image size can be changed by typing new values into the width and height fields, or 
choosing a preset magnification, which will preserve the aspect ratio. 

Note that the option to modify the image size is only available for viewers in Isometric 
mode. 
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Surveys & Grids Loaded-Section indicators 

The basemap grid displayed for loaded surveys in the Surveys & Grids module has been 
extended to show indicators for sections loaded into the Interpret module: 
 

 
 
In the above screenshot, Row 203 has been loaded into the Interpret module in another 
viewer.  The indicator is shown as a bold line in the viewer and appears under the “Section 
indicators” group in the object tree. 
 
The object tree and viewer provide a context menu item on the indicator to allow the 
section to be unloaded from all viewers.  
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Display Method Attribute Histogram 

T7 provides various means of creating data distribution plots for its many attribute types. 
However, an additional tool has been added to create quick histograms of any data 
displayed in the Volume Editor that uses a Display Method. If this Display Method defines 
a filter then this will be used to condition the histogram so that only the filtered data is 
used. 

The below example shows the new tool in action. 

 

The new histogram tool is accessed in the Volume Editor by first selecting the relevant 
object in the viewer (a Fault Surface in the above example), and then using the <MB3> 
Popup Menu option “Fault surface -> Display method -> Attribute histogram”, or using the 
equivalent context tool-bar option, as shown above. The histogram displayed here is 
actually the same as that which is available in the Viewer Colour Bar for the chosen object 
type (e.g. Fault, Horizon etc), but the new histogram option is displayed in more detail in its 
own window which will persist until closed. Multiple histograms can be displayed together 
for comparison purposes. Zoom and pan options are available in the graph area using 
<Shift>+MB2 or <Ctrl>+MB2. 
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Data-Offset for Wells and Surveys 

The T7 Data Offset utility provides a means of applying geometric transformations to many 
T7 data types. The transformations that can be applied include simple XYZ offsets or 
scaling to more advanced arbitrary axis rotations. This tool has now been extended so that 
transformations can be applied to Well and Survey data (ie well paths & picks, 3D survey 
grids & 2D line navigation). This can be useful if data has been imported in the wrong units 
or at the wrong position or it can be used to move copied data to a different location from 
the original. 
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Convert Field-Lines to Shapes 

T7.3 introduced the new Field-Line properties in the Fracture Prediction system – these 
lines represent the orientation of fracture planes where they intersect observation 
surfaces. Though these properties are exportable via the Petrel Link, the support for this 
data on the Petrel side is limited. Now being able to convert the Field-Lines to T7 Shapes 
means that, when required, the data can benefit from improved export functionality. In 
particular, T7 Shapes can be exported to Petrel as Shape data. Also, T7 poly-line Shapes 
can be exported in ASCII format using the “Point-set & shape” export tool accessed from 
the T7 Main Menu and Database Explorer. 
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Polygon Centre-Lines 

Polygon centre-lines are poly-lines that form the central (or average) path between the 
footwall and hanging-wall components of a fault/horizon intersection polygon. These can 
be useful to show the locations of faults when displayed in map-view. 

It is now possible to control the display of polygon centre-lines in the Volume Editor’s 
Model & Map module. The images below show the new Style Editor controls and a number 
of centre-lines displayed on a fault surface. 

 

 

 
 

NOTE: Polygon centre-lines are not stored in the T7 database – moreover, they are 
computed as required at run-time from the fault polygon data.  
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ASCII EXPORT 

Polygon centre-lines can now be exported using the Fault Polygon ASCII Export tool. This 
is accessed from the T7 Control Menu (Data -> ASCII -> Export -> Fault polygons) or from 
the Database Explorer (File -> ASCII Export -> Fault polygons). 
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PETREL EXPORT 

The Petrel Export tool has also been extended to permit the export of polygon centre-lines 
to Petrel: 

 

In addition, when exporting polygons and center-lines, options have been added that 
specify the relationship between T7 polygons and the resulting Petrel polyline-set object. 
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Colourmap Import/Export 

The T7 Colour Map Editor utility now supports the import and export of ALUT files. ALUT 
files are a simple list of 256 comma-separated RGBA colours. Access the Import/Export 
option via a new icon in the Colour Map Editor (as shown below). 

 

To export: set an appropriate filename (or choose an existing file to replace) and click on 
Export to create a new ALUT file from the currently defined colour map. 

To import: select an existing ALUT file using the file selection tool and click on Import. 
This will load the colour data from the chosen ALUT file and display its content in the 
Colourmap Editor. It will also save the imported data as a new colourmap resource 
available in the File drop-down list. 


